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MINIMUM SYSTEM REQUIREMENTS 6) When you are finish with you choices, Cick on the install button to begin installation of DarkSeed I

PROCESSOR: Macintosh computer with a 68040 or PowerMac processor. (The Installation process will create a DarkSeed |1 Folder and Copy selected files to the hard drive. This process

_ , takes about Zminutes.)
REQUIRED: System 7.0 or Later,6 MB RAM, 20 megabytes of hard drive space, double-speed CD-ROM drive.

6) When the installer has completed the file transfer you will be prompted to restart your system.
GRAPHICS: 540X480 resolution with 256 colors. |

7) When the installation is complete the message “Setup Completed” will appear, click OK to proceed. Your

MUSIC: Sound Manager 3.1 or Later ( Included with the installer) system will estart 0 allow changes o take efect

Movie Playback: QuickTime 2.1 or Later ( Included with the installer | B) Toplay Dk Seed I, double-lick the Dark Seed 1 Icon on your deskiop.

HOW TO INSTALL DARK SEED Il TO START DARK SEED II

1) nset te DarkSeed 1 O nt yourCO-ROM drive 1) The Installation process created  folder on your Desktop called DarkSeed ||

1) Doublelick on the arkSeed I CD icon. 7) By double-clicking on this folder you will be able to access the DarkSeed Il Game lcon.
3) Double-click on the DarkSeed |1 Install icon to open the EASY Install screen. %) Again, Double-¢lck on the DarkSeed I con t start the game.

4) Within the Easy install you will find two options in the pull down menu:
A. Easy Install - This Option will Install DarkSeed |1 with the default setting.
B. Custom Install - Allows you to tailor the installation of DarkSeed Il to your Specifications:

(For example, “ Options to select higher levels of installation to which may improve the speed of cinematic
sequences within the game.)
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THE STORY

Has it only been a year? It really seems like more than a century since | took a leave of absence from my adver-
tising agency. All | wanted was some peace and quiet, a place to it and contemplate. .. and write. My life as a
successful ad man was going great, but | wanted more. | got more. When | rented my house-my dream house-in
Woodland Hills, | had no idea what nightmares would hatch like spider eggs in my mind. There was the living
room mirror. .. and the missing piece that came in the mail. And that was just the start.

0, | would rather wipe the whole thing from my memory, but | fear | will never be allowed to forget. No one who
has seen the Dark World could ever drive those images from his head. No one. | broke down completely after it
was over, and took up unwilling residence in a variety of “rest homes" and mental wards. In those sterile halls
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and strapped-down beds, | remembered all too much. There was the Keeper of the Scrolls, who first told me about
the Ancients and their evil plots. (Why me? | asked myself again and again.) And the Ancients, themselves. Grue-
some. Horrific. Sickening. ..

| thought | had destroyed them when | blew up their spaceshi, but the memories. .. the horror.... would not let me
go. | thought | had won, but this past year |'ve often wondered if death would not have been easier. The dreams. ..

Finally, in a kind of paralyzed daze, | moved back home. Mom was there to take me in, a broken, confused man
whose dreams had turned dark and ugly. She didn't really understand my lethargy, my distance. She thought me
dreamy; she had no idea what | dreamed. They said | was in good health, but what did they know about the indeli-
ble stain of the Dark World?

Being home helped, a little, and |'d even begun to think about the normal matters of life again. The simple things.
You know, like dating and having friends. That's where Rita came in. Rita Scanlon, my high school sweetheart.
We hadn't seen each other in a long time, but now that | was back, we were getting reacquainted. Although Rita
had changed and was more distant, | didn't worry about it - after all, | had also changed, and in stranger ways
than most. We went to our high school reunion together, or so they tell me. | don't recall a thing about it. The night
vanished, just one big black hole in my memory. | think | got drunk.

I'm certain that | didn’t murder Rita, though. How could | have?

It's the Dark World. | know it is. They've found me again, and now they've murdered Rita. Sheriff Butler thinks |
did it. He'd never believe the truth. Nobody will believe me.

And my headaches are getting worse. r. Sims just keeps giving me medicine and more medicine. He doesn't
understand either. |'m tired of being medicated all the time. I'm tired of the headaches. But most of all, I'm
scared. The Ancients are back. ..




GAME CONTROLS

DARK SEED I1 is most easily played with an Apple/Macintosh mouse and Keyboard. The corresponding keyboard
controls are the ENTER key (mouse button)and the Space Bar to change the characteristic of the cursor. The
cursor arrow keys control directional movement.

On the screen, you will see an arrow-shaped cursor that you control. To Interact with the game place cursor with
the desired cursor function over an object or pathway and click the mouse button(Action command). When your
CUrSOr is over a connecting doorway which leads to another room or location, this single arrow cursor changes
{0 four inward-pointing arrows.

To make Mike Dawson move, position the arrow cursor wherever you want him to go and click the mouse
button(Action command). Mike will walk to this new position. If there is an unavoidable obstruction in his path,
he will stop at the closest possible point. If you press the mouse button when the multiple arrows are displayed,
Mike will walk to the doorway and then to the adjoining location.

The Space bar is used to cycle the cursor shape througha 7" (look) shape, a “hand” (use/take/talk) shape
and an “arrow” (go) shape.

When the “7" and “hand” cursors are placed over items which have more information available, or which Mike
can pick up or e, th cursor changes shape. The “1" shape changes toa " !”, and the “open hand” shape
changes to a “pointing finger”.

To examine or manipulate an object, select the “7” or “hand” icon using the mouse button, then place it over
the desired object, and click the mouse button to activate. If you use the “hand” icon to pick up an object, it is
added to your inventory. (For more info on inventory, see “Your Inventory” below,)

Keyboard Controls
Spacebar Togoles the cursor fuctions
Enter  Same as mouse button.

Note: The arrow keys or numeric keypad can be used to control directional movement of the pointer.

0 Sound On/0ff M Music On/0ff

P Pause Game A About Box

1 Help F2  Options

F6  New Game F1  Load Game
F§  Save Game F9 Boss ey On/0ff

FIT Walk Speed

Boss Key - The Bass Key can be activated by pressing the [FS] key. This option willinstantly suspend your game
and change your screen to something that looks a bit more productive. Press the [F9] key again to return to the
name.

Walk Speed - The Walk Speed key can be activated by pressing the (F11] key. Tis option will allow you 1o con-
trol how fast Mike Dawson walks. Each time you press the [F11] key, you will toggle between Slow, Medium,
and Fast mode.




GAME OPTIONS

Ypu may access the game option menus by moving the pointer to the top of the screen. There are three menus:
File, Option!, and Help.

Choose the File menu to start a new game, to load an existing saved game, to save the current game in
progress, or to exit back to the desktop.

Choose the Option! menu to display a dialog box with several settings for how the game’s graphics and sound
are played. Options include sound effect and music volume, type of music playback you want, text display speed,
animation resolution, dialog options, and whether to skip or play transitional animations.

Choose the Help menu for instructions on how to play Dark Seed II

THE FILE MENU

To restart, save, load, or quit @ game in progress, move the pointer to the top of the screen. A Macintosh menu
har will appear. Place the cursor over the File menu and click the mouse button to reveal the following options:

New Game

To start a new game from the beginning, click on New Game or press F6. An alert box will appear asking if you
really want to start a new game. Click the YES button to start a new game from the beginning. Click on the Can-
cel button if you change your mind and want to return o your game in progress.

Load Game

To load a previously saved game, select Load Game from the File menu or press F7. You'll see a Macintosh
window displaying a st of saved games. Click on and highlight the saved game you wish to play, then click on Load
at the right of the window. If you change your mind, click on the Cancel button at the bottom of the window.

Save Game

To save a game in progress, select Save Game from the File menu or press F8. You'll see a Macintosh save
window. Type in some descriptive text to remind you where you were in the game in the Macintosh Save as line.
Finally,click on the Save button at the right of the window. If you change your mind, cick on the Cancel button at
the bottom of the window. If you want to re-use one of the slots, simply select that one and type a new description
there. An alert box will appear and ask you if you want to overwrite the previous game. Click Save or Cancel.

bxit

To quit the game at any time, select Exit from the File menu or press the ESC key on your keyboard. You will be
asked if you want to save your current game. Click on the Yes or No button, and the game will end. If you change
your mind, click on the Cancel button.




THE OPTION! MENU

To access the Option! menu, move the cursor to the top of the screen and then click on the word Option! to
open the Play Setting dialog box. There are several options available in this dialog box:

Sound Effect Volume: Use the mouse to move the lider to the right to raise the volume; to the left to lower
the volume of the game’s sound effects and dialogue.

Sound Effects Disable: Click here to disable all sound effects and dialogue.

Music Volume: Use the mouse to move the slider to the right to raise the music volume; to the left to lower the
music volume.

Music Disable: Click here to disable all music.

Text Display Sugedi Click on the radio button that represents the text display speed you prefer. You may
choose Fast Medium, Slow or Click. If you select Click, the text will not advance until you click the mouse
button.

Animations: Click on the appropriate resolution for animations. If you aren’t sure what your display card can
handle, use the default setting.

Dialog Option: Choose the radio button that represents the way you want dialog to be presented in the game.
You can have both audio and text, audio only, or text only.

Skip Transitional Animations: Click on the checkbox if you do not want to view the animations that some-
times appear when you travel to a new location. Even if you skip Transitional Animations, you will still get all the
information necessary for solving the mystery.
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THE HELP MENU

To access the Help menu, move the pointer to the top of the screen and then click on the word Help. An online
version of this manual will initiate, allowing you to more easily search for a topic. You can also access the help
menu by pressing the [F1] key.
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CONVERSATIONS

When Mike is talking with another character, a
Conversation Window will appear at the bot-
tom of the screen. The Conversation Window
contains the choices that Mike can make during a
conversation. To have Mike say something, move
the pointer over the text you want (the selected
text will turn white) and click the mouse button.
Mike will then speak the words aloud and the
other character will reply. When the other character has finished speaking, you may select another option unless
the conversation has ended. Clicking on the mouse button when another character is talking will cause the cur-
rent speech to end, presenting your next option. Be careful not to click too quickly; you might miss a character's
response. When the conversation is over, the Conversation Window will disappear.

To the left of the Conversation Window is a skull icon. When more than three conversation choices are avail
able, arrows will appear allowing you to scroll up or down through additional conversation choices. Be sure to
check for these arrows after another character has spoken. The Conversation Window only shows threg lines
of text at a time. If the arrows appear, you have more conversation choices that you should consider. Use the
arrows to scroll all the way to the end before selecting an option. What you choose for Mike to say can radically
affect the game, o choose with care.
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YOUR INVENTORY

To view your current inventory, move the cursor to the bottom of the screen. The inventory window will appear
at the bottom of the game window. At the beginning of the game, there is nothing in your inventory, but when you
collect items, they will appear as icons in the inventory window. To examine an item in your inventory, place the
“1" cursor over the inventory item and click the mouse button. To use something in your inventory, use the
“hand" cursor. When you click on the item, the cursor will change to the shape of the item selected. Now you
may move the cursor and click where you want to use the inventory item. You may move the cursor anywhere on
the game screen, or even over other inventory items. You'll notice that the cursor will appear as the “hand”
shape unless it is over something that can be manipulated or affected by the item you chose. To de-select an
inventory item after you've selected it, press the mouse button; the item will remain in your inventory.

If you have more items in your inventory than will fitin the inventory window, arrow icons will appear at the left
and right edges of the inventory window. Click on these arrows to scroll through items that are currently not dis-
played.




HELPFUL HINTS

At the start of Mike's adventure, you will only catch glimpses of the Dark World through Mike's dreams. As you
delve deeper into the mystery of Rita’s murder, Mike will have an opportunity to travel to the Dark World again.

Toclear his name, Mike will have to play the role of detective. As he gathers more and more information, be sure
10 visit suspects and other sources of information again. A new piece of evidence may inspire Mike to notice
details he had overlooked on first inspection.

If you can't decide what lead to follow next, sit on the bench at Mike's front porch to see if his friend Jack is
cruising the neighborhood. Jack is a good source of information about the town's dirty little secrets.

Whenever Mike gets a headache, go to Dr. Sims office for therapy sessions. Mike's hypnosis-induced dreams
can provide him insight into what happened during the night of the high school reunion.

Remember that the Dark World is a parallel to our Normal World. Actions in one universe can impact the other
universe, particularly where the convergence is strongest.

Thoroughly explore any mazes you encounter. One maze has a secret that you must exploit to thwart the
Ancients” plans.

Save your game frequently, especially if you are about to try something dangerous or talk to an armed Dark
Worlder. Mike can die in the Dark World if he makes too many mistakes.

Pay attention to the changes in the pointer shapes as you move them over objects and backgrounds. They pro-
vide important clues about your environment.
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BEGINNING WALKTHROUGH

This short walkthrough is intended to help you familiarize yourself with the way Dark Seed Il works. It isn't
meant to take you very far into the game, but simply to show you how to use the Conversation Window and how
o explore the world.

Mike’s Bedroom

At the beginning of the game, Sheriff Butler
shows up at Mike’s door and questions him about
Rita’s murder. In this conversation, it doesn’t mat-
ter too much which options you choose, but some
options will reveal a lot more information. Some
of that information might turn out to be useful
[ater in the game, although obvious statements,
like those about being Iate for the doctor, or hav- :
ing a headache, will bring the conversation to a close.

When Mike's conversation with the Sheriff is over, the Sheriff will leave. Now you can explore Mike's bedroom.
This is a chance to familiarize yourself with the game controls.

1. Use the Space bar a few times and notice how the pointer changes shape. The arrow-shaped icon s the
6o pointer. Use the 60 pointer to move Mike from one place to another. The exclamation point icon is the
Look pointer. Use this pointer when you want to lear about something you see on the screen. The hand icon
is the Use pointer. Use this pointer when you want to pick up or manipulate something on the screen of in
Mike's inventory.
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Note that when you are using the Look pointer, it may appear as a question mark icon. Move it around on the
screen until it tums into an exclamation point, then click to get information about the object underneath the
pointer. Also, although you will use the Go (arrow) pointer to make Mike move around, Mike will also move if you
click on an object with either the Use (hand) or the Look (exclamation point) pointer.

Keyboard Note: If you prefer to play from a keyboard, you can toggle between each of the three pointers by
pressing the Spacebar. You can then use the selected pointer by pressing the [Enter] key.

2. Change the pointer to either the Use or Look icons and move the mouse around. Notice that the pointers
change shape to indicate whether you can interact with a part of the room. For instance, moving either pointer
from the blank wall to the poster of the swashbuckling swordsman above the bed causes the icon to change
“1"toa“1”. When the look icon changes to an exclamation point click the mouse button to get information
about the poster. You'll hear a voice-over comment from Mike. Listen carefully to what he says; there may be
cluginit

3. Next use the Look pointer to examine the trophy, by clicking the mouse button when the icon is directly over
the trophy. Listen to what Mike says.

4. Click on the closet door with the Look pointer, and, again, listen to Mike.

6. Now you can explore other items in the room if you wish, but when you're ready, switch to the Go pointer
(Arrow)by using the Spacebar. Next, move the GO pointer over the exit door on the far right of the screen.
The Go pointer will change to the shape of four arows pointing inward. Click the mouse button. This will cause
Mike to leave the room and enter the Kitchen.

THE KITCHEN

Now you're in the Kitchen. Mike's mother, Mrs. Dawson, is busy at the stove, as usual. Perhaps she has some-
16

thing interesting to say....

6. With the Use pointer, click on Mom. During this first conversation with Mom, you can discover a few more
background facts, but nothing critical. If Mike mentions that he's getting a headache, Mrs. Dawson will remind
him of his medicine. “That's what it's for,” she says.

1. Once you've completed the first conversation with Mom, and she returns to her cooking, click on her again to
get a clue about watching television.

8. With the Look pointer, examine the room. You'll notice some objects on the refrigerator.
9. Switch to the Use pointer and click on the happy-face magnet. Mike will take the magnet and put it in his pocket.

10. Now move the pointer to the bottom of the screen. The Inventory Window will appear, and you'll see that the
magnet has been added to Mikes inventory.

If you click on the magnet (or any object in
inventory) with the Look pointer, Mike will make
some comment or observation about the object. If
you click on the magnet (or any object in inven-
tory) with the USe pointer, the pointer will
change to a shape that resembles the object
you've selected. Try it.

11. With the Use pointer active, click on the
magnet and then move the pointer around in the
room.
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Notice that the pointer looks like a hand until you place it over the refrigerator. Then it changes to look like the
magnet. This tells you that the magnet can be used with the refrigerator. If you click on the refrigerator now, Mike
will return the magnet. To put the magnet back in Mike's inventory, drag the pointer to the bottom of the screen
again, opening the Inventory Window, and click on the magnet again.

12. Assuming you still have the magnet, there’s not much more to do here. Perhaps you will find something to do
in the Living Room. With the Move pointer, click on the door to the right.

Now you're on your own. Good luck. Oh, and if you really need more help...

IFYOU NEED ADDITIONAL GAME PLAY HINTS, YOU CAN REACH OUR
HINT LINE AT 1-300-407-HINT (4466)

You must have a touch-tone phone to use this service. The hint line is available 24 hours a day. The charge is $.95
per minute. You must be 18 or have parental permission to use this service. This service i only available within
the LS.

OR YOU CAN PURCHASE THE OFFICIAL STRATEGY GUIDE BY CALLING THE CYBERDREAMS
ORDER LINE AT 818-225-1048

The Dark Seed |1 Official Strategy Guide is only $19.95 + $6.50 for shipping in the USA, California residents add
8.25% sales tax. Canadian orders add $9.50 (US currency only) for shipping. Visa or Mastercard accepted.
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TROUBLESHOOTING

Memory Problems
Virtual Memory: We have found that turning off virtual memory improves video play back and frees up extra
memory. This is located in the Memory option in the Control Panel under the Apple pull down menu.

Extensions: If you are experiencing low memory messages? Please tum off unnecessary extensions in you
system folder under the Extensions Manager or Extensions. (Extensions necessary for to play; QuickTime; Sound
Manager: and Apple C0-ROM)

Note: Remember you will need to restart you computer for the changes to take effect.

Video Problems
Verify that your screen resolution is 640x480 for best results and that you are using the most current extensions
for your video and monitor.

Audio Problems
Ensure QuickTime 2.1 is properly installed and verify that all required sound extensions are activated.

Mouse Problem
Make sure you are using a 100% Macintosh compatible mouse.

No Multi-tasking
Because of the large amount of system resources that Dark Seed |1 requires, you should not attempt to use any
multi-tasking functions or run other programs while playing Dark Seed II.

Screen Savers
While using Dark Seed Il you should disable any screen savers that are enabled.




TECHNICAL ASSISTANCE

If you are experiencing technical difficulties with Dark Seed II and you are a registered user, you may call
our technical support department for assistance at (818) 222-9348. Cyberdreams technical support is aval-
able during normal business hours (Mon-Fri, Sam to Spm PST). To better serve you, please have information
regarding the manufacturer, model, operating System, available memory and system configuration of your com-
puter when you contact us.

If you have a modem, you can also contact us through our Bulletin Board Service by dialing (818) 223-8739.

ON-LINE SUPPORT VIA COMPUSERVE

For on-ine support of Dark Seed Il via CompuServe, call (800) 524-3388 (in North America) and ask for rep-
resentative #503 to get your FREE introductory membership and $15.00 usage credit. 1f you are already a
member of CompuServe, type the command 60 GAMAPUB at any ! prompt to get the Cyberdreams support area
(Section/Library %), or contact our technical support department at |0# 72662, 120.
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ABOUT H. R. GIGER

H.R. Giger was born in Chur, Switzerland in 1940. As a child, he developed a powerful fascination with all things
surreal and macabre. His need to express himself and share the unique aspects of his vivid imagination drew
him to the visual arts. Giger's own dreams and the brilliant imagery of such fantastique geniuses as Gustav
Meyrink, Jean Cocteau, Alfred Kubin and H.P Lovecraft, combined to form a rich soil from which the amazing
imagery of Giger's art has come to sprout. It has grown into the vast canon of exotic women, wondrously dis-
turbing landscapes and frightening creatures that has captured the fascination of millions of fans worldwide.

Meticulously detailed, Giger's paintings are done on large canvases and worked and reworked by this maestro
of the airbrush. It was Giger's popular art book, Necronomicon, that caught the eye of director Ridley Scott as he
was searching for the right look for a creature in his upcoming film. That creature, of course, turmed out to be the
Alien, and Giger's masterful designs for the film of that same name garnered him a much deserved Academy
Award.

Giger's fascinating biomechanical style, that brilliant synthesis of flesh and machine, has been realized not only
through his paintings, but also through sculpture pieces, elegant furniture, and architectural and interior design
projects. His paintings have been displayed in galleries and museums throughout the world. H.R. Giger has
earned his place in the international art scene.




“Biger is the master of fantastic art”
OMNI MAGAZINE

“Giger's Oscar-winning work on ALIEN changed the look of science fiction”
CINEFANTASTIQUE

“Giger knows what we fear”
HARLAN ELLISON

“his silence is as profound as his genius”
CLIVE BARKER

“One of Europe’s leading fabulist artists”
PENTHOUSE

“Brilliantly perverse”
NEWSWEEK

“The evolutionary genius. . . Giger”
TIMOTHY LEARY

“H.R. Giger creates eerie erotic fantasies with a nightmare imagination and an airbrush”
PEOPLE MAGAZINE
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THE MAKING OF DARK SEED I

“It's beautiful!” was H. R. Giger's enthusiastic reaction upon seeing the original Dark Seed for the first time. As
a world-renowned fine artist, Giger was skeptical when Cyberdreams initially approached him about creating a
computer game based upon his macabre “biomechanical” landscapes. He agreed to grant Cyberdreams access
to his body of work only after lengthy negotiations. But when Giger saw the great care that Cyberdreams had
taken to preserve the elements of his art, he was pleased with how effectively his images translated to an inter-
active environment. Game players were equally pleased with Dark Seed. The game became a sleeper hit,
winning the Software Publishers Association’s 1993 Excellence in Software Award for Best Fantasy Role-Play-
ing/Adventure Game.

Dark Seed players wanted to see more of hero Mike Dawson’s nightmarish journey into Giger's Dark World, and
s0 Cyberdreams brought in game producer David Mullich to create the sequel. Not only had Mullich developed
other adventure games with dark psychological themes such as The Prisoner and | Have No Mouth, And | Must
Scream, he also admitted to being a Giger fan since high school, when he bought an Emerson, Lake and Palmer
album with a cover designed by the Swiss surrealist. With the goal of surpassing the high standards set by the
original Dark Seed, he assembled a development team of the most talented and demented minds working in
interactive entertainment.

Since Giger's disturbing images have had such a profound impact on science fiction literature and cinema —
he designed creatures appearing in the films Alien, Poltergeist Il and Species — it seemed fitting that the
sequel should have a literary quality. Designer Raymond Benson, whose software credits include Stephen King's
The Mist, Ultima V11 -The Black Gate, Return of the Phantom and Are You Afraid Of The Dark?, was commissioned
to write a story that continued Mike Dawson’s horrifying adventures. Instructed that the sequel also must take
Mike Dawson from our Normal World into Giger's Dark World, Benson crafted a psychological murder mystery

that begins in a quirky, “David Lynchian” small town and draws us into a terrifying alternate universe that is a
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metaphor for madness. Those who reach the game’s chilling conclusion will appreciate how well Benson's tale
allegorizes what Giger says about his art: “I expel these creatures, and their pain, by painting them onto a sur-
face, trapping them forever. In a somewhat symbolic manner, | also free myself.”

Giger later requested that the sequel include images that had recently been haunting him, including a sled car-
rying a vat down the banister of an endless staircase (inspired by Giger's “Shaft” pieces). Since Benson had
moved on to other projects, Cyberdreams consulted science fiction author John Shirley (The Eclipse Trilogy, and
the screenplay for “The Crow”) on how to fit Giger's visuals into the sequel, and he also contributed many addi-
tional ideas for fleshing out the Dark World. To put the finishing touches on the game dialogue, Cyberdreams
brought in Keith Herber, a horror author who edited the Call of Cthulhu role-playing game and is an expert on H.
P Lovecraft.

Once the game design was completed, Cyberdreams hired Destiny Software Productions of Vancouver, Canada to
implement it. For the original Dark Seed, Giger had insisted that Cyberdreams use a high resolution VGA graph-
ics mode (640 by 350 pixels, 16 colors) to avoid the “square and jagged” look found in most computer games of
the time. So that the sequel would also be visually cutting edge, Destiny's programming team enhanced their
graphics routines to support an even more advanced graphics mode, SVGA (640 x 480 pixels, 256 colors), while
running under a Windows or Windows 35 environment.

To create the character animations of Mike Dawson and the other Normal World denizens, Destiny photographed
the movements of live models with a high speed camera, scanned the photographs into digital form, and played
images back as animations. In addition to professional performers, some of Destiny's staff members volunteered
to be character models. By a happy coincidence, artist Chris Gilbert was a dead-ringer for the Mike Dawson
character from the original Dark Seed.

The art team at Destiny also proved to be skilled at combining a variety of imagery from Giger's fantastic art-
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work and using both 2-D and 3-D techniques to create new Dark World backgrounds. Several months into the
project’s development, Mullich, Cyberdreams” art director Peter Delgado, and Destiny artist Gregg Haggman vis-
ited Giger's home in Zurich to show off their progress. Giger was very impressed with the graphic improvements
over the original Dark Seed, and offered many helpful suggestions about scaling, placement and composition.
One of his most significant contributions was the placement of metal catwalks throughout the Dark World, so
that Mike Dawson would always feel in peril, being continuously suspended over a bottomless pit.

So that the Normal World would have an equally distinct look, Cyberdreams enlisted the talents of artist Jeff
Hilbers to create the Normal World backgrounds. Hilbers, who has previously served as art director on producer
Mullich’s projects when both were at The Walt Disney Company, brought his unique sense of the macabre to Mike
Dawson’s home town. The quaint images of what superficially appears to be a pleasant community proves on
closer inspection to be infected with perversity, symbolizing the Dark World's growing influence on Crowley,
Texas.

Audio was the final element needed to immerse you into Giger's ghastly universe. Cyberdreams commissioned
television and film composer Mark Morgan (Stephen King's The Stand television mini-Series) to write more than
20 pieces of original MIDI music for the adventure, which music producer David B. Schultz of DBS Music then
specially arranged for optimum performance on the Sound Blaster AWE3Z card. Destiny Software Productions
then added haunting sound effects and ambiance through the game.

With more than forty speaking parts in the adventure, Cyberdreams contracted Lisa Wasserman of Virtual Cast-
ing to cast and direct some of the finest voice-over actors performing in interactive entertainment. The dialogue
sessions were recorded at Lucas Art’s old Skywalker Sound facilities in Los Angeles by Cheshire Multimedia
Sound. Sound engineers Todd Bozung and Greg Chapman digitally enhanced many of the voices to help drama-
tize Giger's world of biomechanoids, goddesses and diabolical creatures.
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Upholding Cyberdreams” reputation for innovative packaging, Director of Sales and Marketing Andrew Balzer
commissioned Bright & Associates to create a box design that was as provocative as the adventure contained
within. The box showcases a portion of Giger's 1978 piece “Illuminatus |,” in which 8 woman's cheek is pierced
by her safety-pin sunglasses. The adventure will be made available through the efforts of Cyberdreams Sales &
Marketing team of Andrew Balzer and Daniel Pelli together with MGM Interactive (responsible for North Ameri-
can distribution) and Cyberdreams” foreign distributors.

The production, development and marketing team for Dark Seed Il have unleashed a new horror into Mike Daw-
son's unending nightmare. As you take this dark journey into the depths of madness, we hope that, as Giger tries
to do with his own artwork, you free yourself of some of your own demons.

ol

ABOUT CYBERDREAMS

Cyberdreams was formed to create high quality interactive entertainment software for home computers and ded-
icated game systems. Each product is designed, scripted and story boarded by game play experts and world
famous artists, designers, writers and filmmakers such as H.R. Giger (Alien, Species), Syd Mead (Blade Runner,
Tron, 2010), Harlan Ellison (the most honored author in the world of imaginative literature) and Wes Craven (cre-
ator of A Nightmare on Elm Street). Cyberdreams” audience is adult science-fiction enthusiasts who appreciate
sophisticated storylines, state-of-the-art animation and cutting-edge interactive technology.
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LIMITED WARRANTY

LIMITED WARRANTY. CYBERDREAMS, INC. warrants to the original consumer purchaser that the diskettes or CO-ROM furnished in this product (here
inafter, Software) will be freg from defects in materials and workmanship under normal use for  period of inety (30) days from the date of purchase
(as evidenced by the receipt of purchase)

CONSUMER REMEDIES. CYBERDREAMS, INC's. entire liability and the original consumer purchasers exclusive remedy shall be, at CYBERDREAMS, INC's
option, repair o replacement of the Software that does not meet CYBERDREAMS, INC.s Limited Warranty and which is returned to CYBERDREAMS, INC.
with a copy of the receipt of purchase. This Limited Warranty is void if failure of the Software has resulted from accident, abuse, or misapplication
Any replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer

PRODUCT IS SOLD AS I5. THE SOFTWARE, DISKETTES OR CO-AOM, DOCUMENTATION AND OTHER ITEMS ARE PROVIDED AS 1S. THERE IS N WARRANTY
OF MERCHANTABILITY, NO WARRANTY OF FITNESS FOR A PARTICULAR USE, AND NO OTHER WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED
REGARDING THE SOFTWARE, DISKETTES OR CO-ROM OR DOCUMENTATION, EXCEPT AS EXPRESSLY PROVIDED IN THE PRECEDING PARAGRAPHS. THE
ENTIRE RISKTO THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE, DISKETTES OR CD-ROM, AND DOCUMENTATION IS ASSUMED BY THE CON-
SUMER

CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL CYBERDREAMS, INC, OR ITS SUPPLIERS BE LIABLE TO THE CONSUMER OR ANY THIRD PARTY FOR ANY
CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES RESULTING FROM POSSESSION, USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING WITHOUT LIM-
(TATION, DAMAGE TO PROPERTY, AND TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY, EVEN IF CYBERDREAMS, INC. HAS BEEN
ADVISED OF THE POSSIBILITY OF ANY SUCH DAMAGES OR LOSS. SOME STATES DO NOT ALLOW LIMITATIONS ON THE DURATION OF IMPLIED WAR-
AANTIES AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND THUS THE PRECEDING LIMITATION AND/OR
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY

LEGAL RIGHTS. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS DEPENDING ON THE LAWS N YOUR STATE. YOU
AGREE THE LIABILITY OF CYBERDREAMS, INC. ARISING OUT OF ANY KIND OF LEGAL CLAIM (WHETHER IN CONTRACT, TORT, OR OTHERWISE) WILL NOT
EXCEED THE AMOUNT YOU ORIGINALLY PAID FOR THE USE OF THIS PRODUCT

COPYRIGHT. The enclosed software product and this manual are copyrighted and all rights are reserved by CYBERDREAMS, INC. No part of this man-
ual or any of the accompanying materials may be copied, reproduced, translated in any form or medium without the prior written consent of
CYBERDREAMS, INC

NOTICE. CYBERDREAMS, INC. reserves the right to make improvements in the product desribed in this manual at any time and without notice

CYBERDREAMS, INC. 23586 Calabasas Road Suite 102 Calabasas, CA 91302
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